JULIE EASTON
www.dphotograp
to detail on Digital Photographer
azine. That's why she's the ideal

person to tell you how to create the
perfect portfolio

ROB ANSELMI

www.chainstyle.com

Rob is our resident Action man this

issue, with a fantastic Big Technique

on the wonders of this time-saving

tool. Turn to page 46 and learn how
to speed up your workflow considerably.

ADAM SMITH

www.advancedphotoshop.co.uk

Adam is the newest recruit on our

sister title Advanced Photoshop.
He's gone > the Sixties with

a psychedelic project on page 50
h he wasn't even born then!).

R - )

TIM SHELBOURNE
www.timshelbourne.com
We've sent Tim dotty this issue, giving
him the task of perfecting Pointilism -
justlike Seurat did in the 1800s. Check
out his fantastic tutorial on page 28
and soon you too can paint like the artist himself.

MATTHEW HENRY

www.matthewhenry.net

Matt's been a bus

GEORGE CAIRNS
Www.georgecaims.com
= 1 He'sgotthat summerfeeling on
L. page 58 with a great lessonin
‘ creating realistic tennis balls! George
also solves your Photoshop queries
in his fab Q&A session on page 74.

rosie.tanne

pscxtrahelp

Digital or

scott.cais!
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JAMES DAVIES

GILES ANGEL

www.angelphoto.co.uk
Giles dives into the depths of
3Dimagery on page 36, witha
wonderfully watery tutorial to wet
your whistle. He tells us how to create
artwork so lifelike it almost swims off the page.
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the big technique Actions

History palette TheHistory palette
containssnapshotsthatare created within

| File Edit Imoga

Actions

Optimise your workflow processes, save

time

or get creative with the powerhouse of actions

Layer Select Filter Vi it

heaction,soyoucancreate or

ariation,

Fit 2

New... CtreN | thenbranchbacktotheoriginalimageor
Open.., Ctr+O marhpr pointinthe document’s history.
Browse... Alt+Ctr+O Createasmany variationsofan imageas
Open As... Atzshiftsctizo | voulike.Complexactionscanbecreated
Open Recent using thismethod.

Edit in ImageReady Shift+Ctri+M

Cose Ctriwe )

Close Al AltsctiteW  JRdE o MRS

Cese and Go Ta Bridge, ., ShifteCtisw  EBL% -

Save s I .

Save As;.. Shift+{trS

Save a Versian.,

Save for Web...

Revert

Ait+Shift4Ctries
F12

Batch...
naction is a series of commands that are recorded PDF Presentation, .
and then run on an existing image, or they create e Mo, Wiichiacin | CreateDroplet.. -
anew document. Actions are one of the most T 5 Conditional Made Thangs..,
Page Satup. Shift+Ctr-F el ‘
powerful Photoshop features, ,f'_'r ﬂf; : :'t'l,f_T F:p Contact Sheet II.,.
% . ; 5 Prirt withy Preview.. T o AR
Actions can be used for common tasks such as rotating Print ‘ l Chrlap Crop and Straghten Photos
mar 4 3 thite rsion. Thev can also be used to iF a =t t Irnage...
images or black and white conversion. They can also be used to Pririt One'Coay Ateshiftactdes | O .mag;
ophisticated frames, text effects, patterns and anything pf",; Criiria.. WI !t;ue ackage. .
else you can dream up, The main things you cannot record are 2 3 ¥ L A
LW _q’J ||_| |
the painting tools. Almost everything else is fair game - even —  Photomerge...
paths, and the use of patterns and shapes. Just remember to Exit ciHQ Merge to HOR...
ensure that all required external files (fonts, layer styles, patterns) §
1ree|lsc pr'o\-ic d when sharing your actions, otherwise the Extended action power The ¥
tes an error, Batchand Droplet commands ;
ctions, try to prepare for every image found under the Automationmenu i S 0
i)GSSib!lé[’\,’__H.|SC]<O‘.:" in mind that if you share actions with allowyoutoextendthe powerof S . -
¢ : . L L sbyrunningyouractionson 77" =
other |__>ec:.p|.e, the version of Photoshop is important. Any new ¥ foldersofimages or creating
Photoshop features incorporated into the action won't work amini executable programtodrop
when the action is run in prior versions. Also name all layers, I" sorfolders overand process
snapshats, etc, and they will work across most Photoshop 1automatically, evenwitt -, ! e
i S i Photoshopclosed. e 4 - .
languages. Finally, ch jour units to ‘percentage’ before o
recording transformations, because the size of yourimages may 7% | T67% 1% 4 1667% 04

change. This helps avoid some action pitfalls.

The Actions palette

The heart of action creation

The Actions palette is where you stop, record and play
actions, as well as create new sets, new actions and delete
actions. And that's just the buttons at the bottom! If you
look at the left side of each action command, there are two
columns. To skip a step when the action plays, uncheck
the checkmark in the first column. The second column
contains a dialog icon. This icon is only available in steps
where additional parameters are required for the step to be
completed (whenever a step has an associated dialog box).
Enable the icon if you want to enter new parameters in the
dialog box each time the action encounters that command
- for example, to change Sharpening parameters for each
image processed with the action. Turn it off if you want to
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have the same parameters run each time the action is played.

The Batch command
Supercharge your actions

The File=Automate=Batch command is an
action powerhouse. It allows you to process
not one, but any number of images within
folders/subfolders with a single action.
Select the action, source (where the images
are located) and destination (where the
image output is stored). Generally, don't
pick Save and Close as a destination, which
overwrites the original files. Instead, create
a folder on your hard drive and use this as a
destination, then select a numbering system
for the images. Select Extension in the last
drop-down. If you have a Save command in
the action, select None as the Destination.

PHOTOSHOP CREATIVE
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Actions

P Stop Delete
Flatten Image Play B
P Convert Mode = ;_t Recording
P Make snapshot — Record Again...
P Channel Mixer ) Insert Menu Ttem..
P Make snapshot Insert Stop...
Select snapshot “After Mode Ch. [neart Path
I Duplicate current layer i ] Al:tﬂ".'_mﬂ:l'ls..;:_ T
P Gaussian Blur Playback Options...
Seb current layer
: Make snapshot o Al Ackons
. Reset Actions
_ Seect snapshot “Afer Mods Ch.. ) IEEER etinniens
e > i i Il Replace Actions...
e . Save Actions,
Extra action goodies from Commands
Adobe Foundatthe mo Frames
Image Effects
Production
——Q Sample Actions
Text Effects
Textures
Video Actions

= __| 3image varistions
P Faux Infrared Conwersion
I Soft Blur

P Color Inwersion

b-4 3 Image Variations F5

Droplets

functior

Droplet

compatibility
If the droplet
is created in

Windows, drag

and drop it over

the Photoshop

icon on the Mac

operating system

before using it. This

updates it for Mac.

The Actions menu
All the commands for action production

Creating mini action programs

Adroplet is asmall program created out of an action.
It's stored as an executable program and used to
process images without having to launch Photoshop.

0 Choose

an action
Highlighttheaction
toturnintoadroplet.
Uncheckstopsanddialog
boxes, orthedropletwill
stopeachtimetheyare
encountered.|It'sbestto
letthedroplethandleany
Saving commands for
you, nottheaction.

Createthe

02 droplet Goto

File>Automate>Create
Droplet. Theactionwill
beentered.HitChooseto
provideaname/location
onyourharddrive/
desktop.Pick Folderas
adestination;enterthe
location/serial naming
schemeforyour photos.
0 Testand use
the droplet
Navigatetothedroplet.
Selectaphoto,groupof
photosorentirefolder.
Click-dragitontopofthe
Dropleticon. Thedroplet
opensPhotoshopand
processestheimages,
and they'reoutputtothe
folderyou specified.

The History palette

The Actions drop-down menu is the place to be for P —

controlling your actions. Button Mode is perhaps -~
the most useful of functions here because it turns
your actions from Action Editing mode into a one-
stop button factory in Photoshop. All action editing
operations are hidden, and clicking any button
automatically runs the action - useful for using
the actions after they are created. At the bottom

of the menu are several of Photoshop's preset
actions, such as commands, frames, text effects
and image actions. The Insert Stop command is
useful for providing instructions to the user, and Insert Menu Item is useful for inserting commands
even when they are not accessible within the image you are working with (for example, if you want to
insert a flatten image command but the image is already flattened - see the main tutorial).

[._a"—.'.
i

The little-known action branching warrior

Most people wouldn't associate the History
palette with actions, but as shown in the
tutorial on the next two pages, it can be an
invaluable tool. Create snapshots to provide
an endless variety of branching points for
your image ideas, and jump back and forth
to and from the image's historical points of
interest, all recorded within your action. In
addition to the History palette, the actions
in and of themselves are learning tools.

By reading through the steps in an action
you can learn how a developer created the
action, solved a problem or used a feature
in Photoshop.
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the big technique Actions

GETTING IN ON THE ACTION

First steps in creating an action

and give the

Zdn assign ita

vhich are

tion and

-ompatibility w

Digital photo frames
Create professional quality layouts with frame actions
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explaining
Actions pal
and click the Allow Continue check
ction when encountering

is @ssential to prc C

jits func 1m Access h&'{}[bp dowr:.-_ the rvpfthlur erof the
t Insert Stop. Now enter an Introduction Message

o%, enabling the user to conti

] this message

through the a

Create an original image history state Clic
drop-down palette and hit New Snapshot.

wvert Mode', As history states can be rec

image

use them to quickly bring the

Text effects
Add a touch of style to your fonts

Actions can be used to create a variety of photo
frames around your images, and since you can
incorporate layer styles into the action, you can

also include bevelling, embossing and inner drop
shadows that create a realistic lighting scenario
where the frame creates a shadow on the image.

To create a quick frame, with the action recording,
alternate between sizing the image up and filling

a newly created layer with colour. When you have
three layers or more created, apply some filters to
each layer and a unique bevelled layer style for each
(don't forget to experiment with the Bevel contours). - :
Then apply the inner shadow to the main image layer, and you have yourself a nice and tidy little
frame. There are a variety of frame actions included on the CD which you can experiment with.

Creating various font effects
is a perfect way to learn
how actions operate. When
creating a specific font
effect, keep in mind that you
have to have the correct font
loaded into Photoshop first.
If the font is not loaded, an
error can occur. Depending
on your effect, the size of . 1 - fafe=,
the font and placement in

the document window will matter. Make sure to provide instructions to the
action user on what type of font is suited to your action. The text effect you
see here is included on this month's CD.

PHOTOSHOP CREATIVE




VARIATIONS ON A THEME

Completing the action

0 Second image variation MNext,

select the After Convert Mode history
snapshot and you can start on the second
variation. Duplicate the layer, naming it ‘Soft Blur
509" and then add a 35-pixel Gaussian blur and
change the Opacity of the layer to 50%. Save a
new snapshot in the History palette and call it
‘Soft Blur'

0 Firstimage variation Create

aFaux Infrared look by going into
Image>Adjustments>Channel Mixer. Check
Monochrome and enter Red -45 Green +200 and
Blue -55. Now create a new snapshot, giving it the
name of 'Faux Infrared’. This records a new history
state. Our first variation is complete.

Save your

action sets
If you only
remember one
thing, remember
this: ALWAYS
save your action
sets to a CD/hard
drive. If Photoshop
crashes or the
default settings
are restored, your
actions won't be lost

0 Third image variation Select

the After Convert Mode history
snapshot again, and perform the steps for
your third variation. For thisone add an Invert
Adjustment layer, and change the layer's blend
maode to Color. Then create a new snapshot
called 'Color Inversion.

e - oy
1 0 Separating the variations
(optional) Snapshots are not saved
with the image, so you may want to create
separate docurnents for each variation. Go to
Image>Duplicate. DO NOT provide a name.
Instead, leave the default. Then go back to the
original image, click the Soft Blur snapshaot,
create a duplicate, go back to the original and do
the same for the Faux Infrared variation.

1 Saving Default names are used for
each copy, so subsequentimages run

with the action aren't overwritten during a save.

Goto File>Save As and save each as a Photoshop

the path and folder are stored; don't change or
move the folder, or the action produces an error.

document without changing the filenames. Note

Ly ':._‘_ 45
1 2 Final action steps [fincluding the

Save command in the action, you can
close all files and include this in the action. Note:
select NO when prompted to save the original
file. This cleans up the workspace. Finally, create
an end Stop without Allow Continue, with a
message saying who you are, where people can
find you, your website or email address.

Pattern generators
Generate an endless variety of seamless patterns

Layout templates
Templates for CDs, DVDs, web and print

If you want to get even more creative,
there are a variety of ways you can
create seamless patterns in Photoshop
using an endless combination of filters,
offsetting and layer masking. If you
record each pattern generator as an
action, you'll never forget how you
accomplished it. Also, these patterns
can be saved and reused as patterns in
Photoshop, for text masking or in layer
styles. To get you started, there are
several pattern generator actions on the
CD. Look inside the action steps, and
you'll unlock the secrets of how each
pattern was created.

You can create a site navigation
template or even a complete
website template in Photoshop. ~
It may take some time, but once °
you get used to creating actions,
it's not difficult to add custom M
shapes, lines, grids, tables =
and anything else you need to 0
complete the template. Layouts
actions can also create CD or

DVD jewel case insert templates

for your printer, publishing templates for newsletters, or scrapbook page
layouts for photos. And if you like a specific template action you've made, you
can duplicate it by holding Alt/Opt and dragging to a new location in the set.
Then tweak the action steps to create a variation on your existing template.
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